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Chapter 1 Introduction to Desktop Applications

SECTION 1 INTRODUCTION

This document describes the operation and functionality of the SL1100 Desktop 
Applications.

SECTION 2 OVERVIEW

The SL1100 Desktop Applications is a new suite of software that allows users to control 
their SL1100 terminal from their PC (Deskset Mode) or the PC itself can become their SL1100 
terminal (SL Softphone Mode). Through licensing control and user selection, the application 
can be tailored to meet the needs of a variety of end users. The SL1100 Desktop Suite is a 
graphical user interface between the end user and the SL1100 and can be operated in two 
modes:

 Deskset

 Softphone

The following utilities are provided as a part of the SL1100 Desktop Suite to support 
additional features to be utilized with the Desktop Applications:

 Configuration Wizard – Steps the user through the process of providing the 
settings that are required to start the desktop application.

 Outlook Add-In – allows the user to dial out, transfer, conference and end call  
through the Contacts folder within Microsoft Outlook.
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TCP/UPD Port and Windows Process Firewall Exceptions

When a firewall is involved in the network between the SL1100 and the Desktop Client 
or Shared Servers.  Refer to Table 1-1 Exceptions to Firewall for Ports for exceptions 
to be made in the firewall for ports and Table 1-2 Exceptions to Windows Process for 
windows processes.       

Table 1-1  Exceptions to Firewall for Ports

Desktop Component
TCP and/
or UDP

Port 
Numbers

Related Program

SIP UDP 5070~5197

Audio RTP UDP 60000~60254

Outlook Integration/Highlight Dial/CallToTag/XML API TCP 20864~20865

1st-Party Call Control TCP 8282 10-20-1 Device 0 – 1st-Party CTI

Table 1-2  Exceptions to Windows Process

Windows Process Firewall Exceptions

NECSLPhone.exe
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SECTION 3 INSTALLATION CONSIDERATIONS

The Desktop Applications can only be installed in standalone mode since Shared 
Services are not available with this version of the Desktop Suite.

3.1 Standalone Configuration

In the standalone configuration, each PC with the Desktop Applications has its 
own connection to the SL1100. The Desktop Applications communicates to 
the SL1100 via the LAN on the TCP port defined for the 1st-Party CTI 
connection in Program 10-20-01, although a 1st-Party CTI license is not 
required for the Desktop Applications. The 1st-Party CTI connection is device 
9 in 10-20-01 and the recommended port is 8282.

3.2 O&M (Operation and Maintenance)

The Desktop Application can have a second connection to the SL1100 for 
O&M (Operation and Maintenance). O&M allows the Desktop Application to 
synchronize with the SL1100 when new buttons are added to the extension 
the Desktop is controlling, and synchronize feature access codes when they 
have been changed in the SL1100.  The Desktop Application communicates to 
the SL1100 for O&M information on the TCP port defined for O&M in Program 
10-20-01. The O&M  connection is device 11 in 10-20-01 and the 
recommended port is 8010.

Refer to Figure 1-1 Desktop Connections on page 1-4 for a diagram of the 
connections for the standalone and O&M configurations.

3.3 Remote Connections

In the first release of the SL1100, Network Address Translation (NAT) is not 
supported.  Because of this, any Desktop Applications must appear to be on 
the same network as the SL1100 VoIP Interface (VOIPDB).  For remote 
Desktop Applications, such as the Softphone, this can be achieved using a 
VPN connection to the network where SL1100 resides.
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SECTION 4 SYSTEM REQUIREMENTS

The minimum recommended PC requirements and the supported operation systems 
are described in this section.

4.1 Minimum PC Requirements

The minimum recommended PC requirements for running the desktop 
application are as follows:

 PC Class: Pentium 3

 Processor Speed: 1GHz

 RAM: 512MB Minimum, 1GB Recommended

 Display: Super VGA (800 x 600) or higher

Figure 1-1  Desktop Connections
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 Available Disk Space: 50MB

 CD-ROM Drive

 Network Adapter

 Sound Card

 Microphone/Headset/USB Handset (optional)

 Speakers (optional)

4.2 Supported Operating Systems

The desktop application is supported on the following operation systems:

 Windows 7 Professional, 32- and 64-Bit

 Windows 8, 32- and 64-Bit

 Windows 8.1, 32- and 64-Bit

 Windows 10, 32- and 64-Bit (SL Desktop Suite 2.5 and higher)

4.3 Licensing

The licensing options for the SL1100 Desktop Suite includes support for Soft 
Phone and Deskset modes. The following table shows the license codes that 
will be used with different Desktop Suite operational modes.  

The SL Desktop Suite will allow the user to run in trial mode for a period of 90 
days from initial start-up. During the trial period, the SL Desktop Suite will not 
retrieve the required licenses from the telephone system.

Table 1-3  SL1100 Licensing Codes

License Code in 10-50-01
PCPro License Description

Part 
Number

Name Description
5501

Softphone
5505

Deskset

1100087 SL-DT Desktop 
Suite 1-LIC

Desktop Suite 
License - 1

1 1

SL-DT-CRM Integration-LIC part number 1100095 is required (License code 5510).
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4.4 SL1100 Hardware Requirements

At a minimum, the SL1100 requires the following hardware:

 CPU – Processor

 MEMDB – Memory Daughter Board

 VoIPDB – VoIP Daughter Board
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Chapter 2 Installation

The installation of the SL1100 Desktop Applications includes prerequisite software, if 
the installation determines these do not already exist on the PC.

The following prerequisite software is installed:

 Microsoft .NET Framework

 Microsoft Visual C++ Redistributable

After the prerequisite software is installed, the NECDesktop.msi installs. This 
installation includes the following applications:

 SL1100 Desktop Application

 Microsoft Outlook Add-In

The Desktop Applications are installed in the following directory:

 C:\Program Files\NEC\NEC SL Desktop Suite

Application logs are in the following directory:

 C:\Documents and Settings\All Users\Application Data\SL1100 Application 
Suite\PC Phone\Log Files

After installation is complete, the following application environment is available,  
depending on what installation options where chosen:

 Program group named “NEC”

 Within NEC group are the following:

 NEC SL Desktop Suite

 NEC SL Desktop Suite Configuration

 A shortcut for Desktop Applications installs on the Windows desktop.
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SECTION 1 INSTALLATION STEPS

Installation of NEC’s SL1100 Desktop Suite will not be accomplished through a simple 
installation process that is targeted towards the end user. The decision points within 
the installation process will be clearly explained to eliminate the need for any support 
calls.

1.1 Distribution Format

The installation of the SL1100 Desktop Suite will be designed for distribution 
by CD or DVD. The folder structure for the CD/DVD will be defined by NEC in 
a separate document. Red Phoenix will provide NEC with a self-extracting 
setup file for inclusion on the distribution media.

1.2 Installation Procedure

The following sections describe the installation process for NEC’s SL Desktop 
Suite.

1.2.1 Prerequisite Installations

The installation process will start by examining the host machine to 
determine if the required prerequisite utilities are already installed. 
The prerequisite software for this application may include:

 .NET Framework

 Visual C++ Redistributable

If any of the required prerequisites are not installed on the host 
machine, the installation procedure will initiate the setup program for 
the required utilities.
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1.2.2 Application Installation

After the required prerequisites are verified, installation of the SL 
Desktop Suite application begins. The first screen displays the 
Software License Agreement, which the user must accept for the 
installation to continue.  

If the user clicks on the No button, the installation process 
terminates. After acceptance of the SLA, the installation process will 
continue by extracting compressed files from the installation image. 
The installation window shows the progress as the files are being 
extracted.  

Figure 2-1  Software License Agreement

Figure 2-2  Extracting Progress Screen
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Once file extraction completes, the installation process continues 
and the Welcome screen for the setup wizard is displayed.  

Clicking on the Next button continues the installation wizard. The 
next screen asks the user to specify the destination folder for the 
application.  

Figure 2-3  NEC Welcome Wizard

Figure 2-4  Select Installation Folder
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By default, the application is installed at C:\Program Files\NEC\NEC 
Desktop Suite SL.

The user can click on the Browse button to open a folder navigation 
window.

Clicking on the Disk Cost button opens a window that displays 
available and required space on each available drive.  

After the destination folder has been specified, a confirmation screen 
displays allowing the user to start installation of the application.  

Figure 2-5  Disk Space Screen

Figure 2-6  Confirmation Screen
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Clicking on the Next button starts the installation of the application. 
As the installation proceeds, an installation window displays the 
overall progress, as shown below.  

When the installation completes, the following is displayed.  

Click on Close button to complete the installation process.

Figure 2-7  Installing NEC Desktop Screen

Figure 2-8  Installation Complete Screen
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1.3 Program Access

As part of the installation process, the following program access points are 
established:

 A program shortcut is added to the Windows Desktop to launch the SL 
Desktop Suite application. 

 A new program group labeled NEC is added to the Programs list.

 The NEC program group includes entries for Desktop Suite SL and 
Desktop Suite SL Configure to launch the application and the 
configuration wizards, respectively.

Figure 2-9  Desktop Suite Icon
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SECTION 2 SL1100 DESKTOP SUITE SYSTEM PROGRAMMING

The following table lists the SL1100 System programming related to the Desktop 
Suite.

Table 2-1  SL1100 Desktop Suite System Programming

Program Description Input Data

10-12-03 CPU Network - Default 
Gateway

Define the default gateway to be 
used by the VOIPDB interface.

0.0.0.0 ~ 126.255.255.254
128.0.0.1 ~ 191.254.255.254
192.0.0.1 ~ 223.255.255.254

Default = 0.0.0.0

10-12-09 CPU Network Setup - 
IP Address

Define the IP Address for the 
VOIPDB interface.

0.0.0.0 ~ 126.255.255.254
128.0.0.1 ~ 191.254.255.254
192.0.0.1 ~ 223.255.255.254

Default = Slot 1 = 172.16.0.10
Slot 4 = 172.16.0.13

10-12-10 CPU Network Setup - 
Subnet Mask

Define the Subnet Mask for the 
VOIPDB interface.

128.0.0.0
240.0.0.0
254.0.0.0
255.192.0.0
255.248.0.0
255.255.0.0
255.255.224.0
255.255.252.0
255.255.255.128
255.255.255.240
255.255.255.254

192.0.0.0
248.0.0.0
255.0.0.0
255.224.0.0
255.252.0.0
255.255.128.0
255.255.240.0
255.255.254.0
255.255.255.192
255.255.255.248
255.255.255.255

224.0.0.0
252.0.0.0
255.128.0.0
255.240.0.0
255.254.0.0
255.255.192.0
255.255.248.0
255.255.255.0
255.255.255.224
255.255.255.252

Default = 255.255.0.0
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10-20-01 LAN Setup for External 
Equipment - TCP Port

Define the TCP port for the LAN 
CTI and O&M communication 
between the CPU and the 
Desktop Suite.

0 ~ 65535
Device 1 (CTI Server) = 0 (Port 8181 recommended).

Default = Device 9 (1st Party CTI) = 0 (Port 8282 
recommended) 
Device 11 (O&M Server) = 8010

10-46-01 DR700 Server 
Information Setup - Register 
Mode

Define the way the Desktop 
Application Softphone will 
register with the system. Desktop 
configuration must be set to 
match this setting or it will not 
launch.

Refer to Chapter 5 Desktop 
Registration and Softphone 
Override for more information 
about registration mode.

0 = Plug and Play
1 = Auto
2 = Manual

Default = 0

0 = Plug and Play
When the softphone launches, it will report the 
extension assigned in the Desktop Configuration or 
choose the next available extension in the system. No 
password required.

1 = Auto
If set to auto then the SIP user name and password 
must be entered in the Desktop Configuration. These 
settings must match 84-22/15-05-27 or the Softphone 
will not come online. 

2 = Manual:
When the Desktop Application launches, it will prompt 
user to enter a user id and password before logging in. It 
checks this user id/password against 84-22/ 15-05-27. If 
there is no match, the Softphone will not come online.

15-05-27 IP Telephone Terminal 
Basic Data Setup - Personal ID 
Index

Used when the softphone or SIP 
multiline terminal is using manual 
or auto registration. Assign each 
phone a unique personal index. 
Then go to command 84-22 to 
assign the user name and 
password.

0 ~ 512

Default = 0

15-05-28 IP Telephone Terminal 
Basic Data Setup - Additional 
Information Setup

Talking Party Off
Set to 0 for Desktop Application 
softphone.

0 = Disable
1 = Enable

Default = 0

15-07-01 Programmable 
Function Keys

Assign function keys such as 
DSS/One Touch Trunk 
Appearance keys to the Desktop 
Application station.
 To retrieve an internal call on 

hold, the station needs an 
ICM key (00).

00 ~ 99, 00 ~ 99

Default = Keys 1~6 assigned 01 for the first six trunks 
in the system

30-01-01 DSS Console 
Operating Mode

Set the mode for the system 
DSS consoles.

0 = Business Mode
1 = Hotel Mode

Default = 0

Table 2-1  SL1100 Desktop Suite System Programming (Continued)

Program Description Input Data
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30-02-01 DSS Console 
Extension Assignment

Assign which extensions have 
one of the 12 DSS consoles 
associated with them.

The extension number for the multiline terminal 
connected with the DSS console (up to eight digits).

30-03-01 DSS Console Key 
Assignment

Assign the key assignments for 
60-button DSS Consoles. A DSS 
Console key can have any 
function with up to four digits 
(example: DSS/One Touch or 
Trunk key).

00 ~ 99, 00 ~ 99
DSS keys 01~60 of all DSS Consoles = DSS/One-Touch 
Key 101~160. 
DSS Keys 61~114 of all DSS Consoles = None

84-20-02 SIP Extension Basic 
Information Setup - Session 
Timer Value

Set to 0 for Desktop Application 
softphone.

0 ~ 65535

Default = 180

84-20-03 SIP Extension Basic 
Information Setup - Minimum 
Session Timer Value

Set to 0 for Desktop Application 
softphone.

0 ~ 65535

Default = 180

84-22-01 DR700 Multiline Logon 
Information Setup - User ID

Input the User ID for each 
Personal ID Index (1-84) when 
using auto or manual registration 
in 10-46-01.

Up to 32 characters

Default not assigned

84-22-02 DR700 Multiline Logon 
Information Setup - Password

Input the Password for each 
Personal ID Index (1-84) when 
using auto or manual registration 
in 10-46-01.

Up to 16 characters

Default not assigned

84-22-04 DR700 Multiline Logon 
Information Setup - Log Off

Enable or Disable the ability for 
each SIP multiline or softphone 
to log off and to be overridden by 
another SIP multiline or 
softphone.

1 = On (Enable)
0 = Off (Disable)

Default = 1

84-26-01 VOIPDB Basic Setup 
(DSP) - IP Address

Assign IP addresses to the DSP 
resources on the VOIPDB.

0.0.0.0 ~ 126.255.255.254
128.0.0.1 ~ 191.254.255.254
192.0.0.1 ~ 223.255.255.254

Default = Slot 1 =172.16.0.20 
Slot 4 = 172.16.0.44

Table 2-1  SL1100 Desktop Suite System Programming (Continued)

Program Description Input Data
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SECTION 3 CONFIGURATION WIZARD

The Configuration Wizard steps the user through the settings that the application 
requires to connect to the SL1100 Telephone System and to initialize the appropriate 
application type.

3.1 Configuration Startup

The initial configuration settings will be requested through a simple 
configuration wizard that will run when the application is started for the first 
time. The text and field labels are targeted toward the end user and utilize as 
many confirmation checks as possible.

The Configuration Wizard can be started manually at Start/All Programs/NEC/
NEC SL Desktop Suite Configure.

3.2 Configuration Wizard, Welcome Screen

The first screen of the configuration wizard is a welcome screen that 
introduces the steps required to navigate through the setup.   

Figure 2-10  Configuration Wizard – Welcome Screen
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3.3 Configuration Wizard, Network Interface

If the application detects multiple NIC cards in the host computer, then the 
next setup screen will be displayed. If there is only one NIC card in the 
system, then the following screen will not be displayed.    

Figure 2-11  Configuration Wizard – Network Interface



SL1100 Issue 3.01

Desktop Suite 2 - 13

___________________________________________________________________________________

___________________________________________________________________________________

3.4 Configuration Wizard, IP Address

The next screen prompts the user to enter the IP Address or Network Name of 
the SL1100 telephone system.  

Figure 2-12  Configuration Wizard – IP Address



2 - 14 Installation

___________________________________________________________________________________

___________________________________________________________________________________Issue 3.01 SL1100

3.5 Configuration Wizard, Installer Credentials

If desired, enter the Installer Level login credentials from Program 90-02-02 
(i.e. User Name: sltech, Password: 12345678). This allows the Wizard to 
retrieve current configuration settings from the telephone system.  

Figure 2-13  Configuration Wizard – Installer Credentials
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3.6 Configuration Wizard, Ports

When the user has entered the IP Address and presses Next, the 
configuration wizard will ask the user to enter the port numbers required by the 
application.  

Figure 2-14  Configuration Wizard – Ports
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3.7 Configuration Wizard, O&M

After the user has entered the required port numbers and presses the Next 
button, the configuration wizard will prompt the user to enter the O&M settings.  

Figure 2-15  Configuration Wizard – O&M
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3.8 Configuration Wizard, Operational Mode

After the O&M settings have been entered and the Next button is pressed, the 
configuration wizard will ask the user to select the operational mode for the 
application.  

Figure 2-16  Configuration Wizard – Operational Mode
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3.9 Configuration Wizard, Extension

After selecting the operational mode enter the desired extension number.  

Figure 2-17  Configuration Wizard – Extension
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3.10 Configuration Wizard, System Mode

If the user has selected to run the application in Softphone mode, the following 
sequence of screens are displayed.  

Figure 2-18  Configuration Wizard – System Mode
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3.11 Configuration Wizard, Audio Device

After the user has specified the current Login information, they are prompted 
to select the Audio Device.  

 The Audio Device lists all of the audio devices that are installed on the 
Host PC.

 The selected Audio Device is used to control the microphone and 
speaker functionality of the IP Softphone.

 The Ring Volume slider controls the level of ringing for incoming calls to 
the IP Softphone.

 The Special Audio lists the additional devices that are available for use, 
such as USB handsets or headsets.

 The Cradle Hook option when selected enables the hook function by 
lifting the handset up/down from the cradle.

 The Local Ring option when selected enables notification of an incoming 
call through the USB device.

 The Volume control sets the level of the ring tone, when Local Ring is 
enabled.

 The Headset Hook when selected enables the hook function by lifting the 
headset up/down from the cradle.

Figure 2-19  Configuration Wizard – Audio Device
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 The Use analog headset port option when selected enables the use of 
the headset port for an analog headset connected to the USB device.

 The F1-F4 fields set the function key assignments for each of the four 
function keys on the USB Handset.

 The Back button returns to the previous Configuration Wizard menu.

 The Finish button completes the Configuration Wizard and closes the 
menu.

SECTION 4 CONFIGURING DIALING RULES

When making calls to outside numbers using the SL Desktop Suite or Outlook Add-In, 
current dialing rules are followed. Use the following to configure individual dialing 
requirements.

1. From the Control Panel select Phone and Modem. Under the Dialing Rules 
tab click on Edit.   

Figure 2-20  Phone and Modem – Dialing Rules Tab
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2. Under the General tab enter the trunk access codes.  

Figure 2-21  Edit Location – General Tab
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3. Select the Area Code Rules tab and enter the local Area Code information.

 In ten digit dialing areas, each area code may need to be defined within the site’s location 
setup. 

4. Click on OK to apply changes.

Figure 2-22  Edit Location – Area Code Rules Tab
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SECTION 5 CHANGING AUDIO SETTINGS IN WINDOWS 7

(Only applies when using Windows 7 or WIndows Vista)

Successful operation of the softphone within Windows 7 requires that the audio 
properties be set to a supported format. The default settings for the audio device must 
be set within the range of values shown in the following table. 

5.1 To change the Audio Properties for the Playback device:

1. On the Windows Control Panel, select the Sound option. 

2. On the Playback tab, select the device to be changed and press the Properties 
button. 

Table 2-2  Default Audio Settings

Sampling frequency (Hz) 8000 / 16000 / 32000 / 48000

Quantization bit 16 bit

Channel all values supported

Figure 2-23  Setting Playback Properties
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3. Select the Advanced tab and set the Default Format to a supported setting, as 
shown in Figure 2-25 Advanced Playback Settings on page 2-26.  

Figure 2-24  General Playback Settings
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4. Select OK to save the settings. 

5.2 To change the Audio Properties for the Recording device:

1. On the Windows Control Panel, select the Sound option. 

2. On the Recording tab, select the device to be changed and press the 
Properties button. 

Figure 2-25  Advanced Playback Settings
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Figure 2-26  Recording Properties Screen
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3. Select the Advanced tab and set the Default Format to a supported setting 
Refer to Figure 2-28 Advanced Recording Settings on page 2-29. 

Figure 2-27  Recording Settings
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4. Select OK to save the settings.

Figure 2-28  Advanced Recording Settings
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Chapter 3 Toolbar Functions

SECTION 1 TOOLBAR FUNCTIONS

The function buttons which appear in the toolbar on the Full Window provide access 
to the operations that are most frequently used by the phone user. The set of function 
buttons which are displayed can be customized by the user, as well as the size, order, 
and hotkey associated with the function. Configuration of the toolbar button layout is 
described in Chapter 7 Application Level Configuration.

Each button changes from active to inactive depending on the state of the calls 
managed by the application. The following table shows the set of functions that are 
active for different phone states.  

Each of the feature keys available in the function toolbar and their associated actions 
are described in the following sections.

Table 3-1  Set of Functions – Telephone States

Phone 
State Call Active Idle or Idle 

with Held Calls
Idle 

Ringing
Call 

Active+Ringing

Feature 
Set

Hold Dial Answer Hold

Transfer Page Redirect Transfer

Hang Up Unpark Hang Up

Conference Barge In Conference

Park Directed Call Pickup Redirect

Group Call Pickup Park

Pickup Other Group

Last Number Redial

Call Forward

Do Not Disturb
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1.1 Answer

 The Answer button allows the user to pick up a ringing line.

 If only one line is ringing, then the Answer button connects the user to the 
ringing line and this becomes the active call.

 If multiple calls are ringing, then the Answer key selects the oldest call.

 If another trunk call is Active when the call is answered, then the original 
call is automatically placed on hold.  If another internal call is Active when 
the call is answered, the original call is disconnected.

 When a call is answered, the Active Call area is updated with an entry for 
the new call.

1.2 Hold

 The Hold function places the current active call on hold.

 The Active Call entry changes from indicating Active to Held.

 After the Hold function is selected, the current Active Call area is empty.

1.3 Transfer

The Transfer button initiates a transfer of the active call. When Transfer is 
initiated, the Transfer dialog is displayed (Figure 3-1 Transfer Call Screen). 

 The user can manually enter the number to be dialed in the Destination 
field using the number keys in the main area of the keyboard or the 
number keys on the keyboard's keypad.

 Alternately, the user can select an entry from the Destination drop down 
list.

 The Destination drop down list includes a list of the most recent transfer 
destinations entered in this dialog box.

The actions associated with each of the dialog buttons are described in the 
following sections.

Figure 3-1  Transfer Call Screen
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1.3.1 Transfer Call – Start

When the Start button is selected, the software will initiate a 
supervised transfer of (blind transfer may be selected from the Shortcuts 
tab in Preferences) the call. The Transfer dialog will be updated (refer 
to Figure 3-2 Transfer Call – Start).  

 Selecting the Complete button will connect the original caller to the 
destination and disconnect the user.

 Selecting the Disconnect button will hang up from the call to the 
Destination, and reconnect to the original caller.

1.3.2 Transfer Call – Blind

 When the Blind button is selected, the application will initiate an 
unsupervised transfer to the specified destination.

 Once the transfer is complete, the active call will be removed from the 
active call area.

1.3.3 Transfer Call – Cancel

 When the Cancel button is selected, the transfer operation will be 
cancelled and the Transfer dialog will be closed.

 Pressing the Esc key will also initiate the Cancel operation.

1.4 Hang Up

  The Hang Up button will disconnect the user from the active call.

 When the active call is disconnected, the associated entry in the Active 
Call list will be removed.

Figure 3-2  Transfer Call – Start
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1.5 Dial

The Dial button allows the user to initiate an outbound call. When Dial is 
selected, the Dial following dialog will be displayed (refer to Figure 3-3 Dial 
Screen).  

 The user can manually enter the number to be dialed in the Destination 
field using the number keys within the main area of the keyboard or the 
number keys on the keyboard keypad.

 Alternately, the user may select an entry from the Destination drop down 
list.

 The Destination drop down list includes a list of the most recent dial 
destinations entered within this dialog box.

The actions associated with each of the dialog buttons are described in the 
following sections.

1.5.1 Dial – Start

 When the Start Call button is selected, the software will initiate an 
outbound call to the specified destination.

 The Active Call list will be updated to include an entry for the dialed call.

1.5.2 Dial – Cancel

 When the Cancel button is pressed, the Dial dialog will be closed.

 The user may also initiate the Cancel operation by pressing the Esc key 
on the keyboard.

Figure 3-3  Dial Screen
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1.6 Conference

The Conference button will initiate a conference that adds a third party to the 
active call. When the Conference function is selected, the following menu will 
be displayed (refer to Figure 3-4 Conference Call – Start).  

 The user can manually enter the number to be dialed in the Destination 
field using the number keys within the main area of the keyboard or the 
number keys on the keyboard keypad.

 Alternately, the user may select an entry from the Destination drop down 
list.

 The Destination drop down list includes a list of the most recent 
conference destinations entered within this dialog box.

The actions associated with each of the dialog buttons are described in the 
following sections.

1.6.1 Conference Call – Start

When the Start button is selected, the application will place the 
original call on hold and initiate a consultation call to the specified 
destination (refer to Figure 3-5 Conference Call – Complete).  

Figure 3-4  Conference Call – Start

Figure 3-5  Conference Call – Complete
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 Selecting the Complete button adds the consultation call to the original 
call, completing the conference setup.

 Selecting the Disconnect button hangs up the consultation call and 
reconnects to the original caller.

1.6.2 Conference Call – Cancel

 When the Cancel button is selected, the conference operation is 
cancelled and the Conference dialog is closed.

 Pressing the Esc key initiates the Cancel operation.

1.7 Page

The Page button allows the user to access the internal and external paging 
functions. When the Page function is selected, the following form will be 
displayed (refer to Figure 3-6 Page Screen).  

 The user specifies the Page zone category by selecting Internal, External, 
or Combined.

 Within each Zone category, the combo box includes all of the available 
paging zones.

 Selecting Start will initiate a Page to the designated paging zone.

 Selecting Cancel will close the Page dialog without generating a Page.

Figure 3-6  Page Screen
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1.8 Park

The Park button will transfer the active call to a specific park orbit. When this 
function is selected, the following dialog will be displayed (refer to Figure 3-7 
Park Call Screen).  

 The spinner control allows the user to select the destination Park orbit.

 With Desktop Applications users can park calls in the next available park 
orbit by choosing orbit 0 when program 20-11-27 is set to 1 (on).

 Selecting the Start button will place the active call in the selected Park 
orbit.

 The Parked Call shows up in the active call list as a blue Parked Call.

 Selecting the Cancel button will close the Park Call dialog without initiating 
a call park operation.

 If the Park operation fails because the selected Park orbit is not available, 
an error message will be displayed.

1.9 Unpark

The Unpark button will retrieve a call from a specific park orbit. When this 
function is selected, the following dialog in Figure 3-8 Unpark Call Screen, will 
be displayed. 

Figure 3-7  Park Call Screen

Figure 3-8  Unpark Call Screen
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 The spinner control allows the user to select the destination Park orbit.

 Selecting the Start button will attempt to retrieve a call from the specified 
Park orbit.

 Selecting the Cancel button will close the Unpark Call dialog without 
initiating a unpark operation.

 If the Unpark operation fails because the selected Park orbit is not 
occupied, an error message will be displayed.

1.10 Barge In

The Barge In button allows the user to enter another extension’s established 
call. When this function is selected, the following dialog will be displayed (refer 
to Figure 3-9 Barge In Screen).  

 The Number field allows the user to enter the extension to Barge In.

 The Number field pull down list includes the most recent entries for this 
field.

 When the Start button is selected, the Barge In feature will be applied to 
the selected extension.

 When the Cancel button is selected, the Barge In dialog will close.

 If the Barge In operation fails, an error message will be displayed.

 The Barge In operation will fail if the specified extension does not have an 
established call.

 The Barge In operation will fail if the user does not have the appropriate 
Class of Service permissions to execute Barge In.

Figure 3-9  Barge In Screen
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1.11 Directed Call Pickup

The Directed Call Pickup function allows the user to pickup a ringing call from 
a specified extension. When the Directed Call Pickup function is selected, the 
following dialog will be displayed (refer to Figure 3-10 Directed Call Pickup 
Screen).   

 The Pickup Type field is automatically set to Directed Call Pickup.

 The Number field allows the user to specify the extension to be picked up 
by either manually entering a number or selecting a number from the pull 
down list.

 The Number field is a pull down menu that stores the most recent text 
entered in this field.

 Pressing the Start button initiates the Call Pickup for the specified 
extension.

 Pressing the Cancel button closes the Call Pickup dialog without executing 
the call pickup operation.

 The Pickup Type field allows the user to initiate other call pickup features, 
including Group Call Pickup, Pickup Other Group, and Call Pickup Specific 
Group.

1.12 Group Call Pickup

The Group Call Pickup function allows the user to pickup a ringing call from 
within their call pickup group. When the Group Call Pickup function is 
selected, the phone will initiate the group call pickup.

Figure 3-10  Directed Call Pickup Screen
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1.13 Pickup Other Group

The Pickup Other Group function allows the user to pickup a ringing call from 
within another call pickup group. When the Pickup Other Group function is 
selected, the phone will initiate the other group pickup function.

1.14 Last Number Redial

The Last Number Redial function allows the user to easily initiate a call to a 
previously dialed number.

1.15 Call Redirect

The Call Redirect function allows the user to send a call that is ringing on their 
extension to a different destination. The Call Redirect function is enabled 
when an external call is ringing into the user’s phone. Selecting the Call 
Redirect function will transfer the ringing call to the pre-defined redirect 
location (refer to Figure 3-11 Call Redirect Screen).  

Figure 3-11  Call Redirect Screen
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1.16 Call Forward

The Call Forward function allows the user to set their phone to automatically 
redirect incoming calls. When the Call Forward function is selected, the 
following dialog will be displayed (refer to Figure 3-12 Call Forward Screen).   

 This function can be used to either activate Call Forwarding or to Cancel 
Call Forward settings.

 The Forward On field determines the conditions for Call Forwarding. 
Available options are:

 Busy or Not Answered

 Immediate

 Not Answered

 Both Ring

 Busy

 The Destination field specifies the phone number to receive the forwarded 
calls.

 The Destination field includes a drop down list which saves the previously 
specified forward destination.

 Pressing the Start button will initiate the Call Forward operation.

 Pressing the Cancel function will close the Call Forward dialog without 
changing the settings.

Figure 3-12  Call Forward Screen
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1.17 Do Not Disturb (DND)

The Do Not Disturb function allows the user to set their phone to block 
incoming calls. When the Do Not Disturb function is selected, the following 
dialog will be displayed (refer to Figure 3-13 Do Not Disturb Screen).  

 The Do Not Disturb dialog allows the user to either set DND or clear a 
previous DND setting.

 When “Set Do Not Disturb” is selected, the user can specify the DND 
condition using the “Applies to:” field.

 The available DND options presented in the “Applies to” field are:

 All Calls

 Outside Calls

 Paging/Intercom/Forwards/Transfers

 Call Forwards

 The “Cancel Do Not Disturb” is selected to remove a previous DND 
setting.

 Selecting the Start button will initiate the requested DND operation.

 Selecting the Cancel button will close the Do Not Disturb dialog without 
processing the DND request.

1.18 Auto Handset/Auto Headset

 The Auto Handset/Auto Headset button is a toggle button that switches 
between using the Handset or Headset for making outgoing calls and 
answering incoming calls.  A Headset button must be programmed on the 
phone (15-07-01).

 The Auto Handset/Auto Headset button is only available when the phone 
is in an idle state.  Toggling between Handset and Headset is not 
supported during an active call.

Figure 3-13  Do Not Disturb Screen
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1.19 Add Note

The Add Note function can be used to annotate the active call. When the Add 
Note function is selected, the following dialog will be displayed (refer to Figure 
3-14 Add Note Screen).  

 The Note field allows the user to enter a text message that will be saved 
with the call record.

 Selecting the OK button will close the Add Note dialog and attach the note 
to the call record.

 Selecting the Cancel button will close the Add Note dialog without 
changing the note field.

 The Clear function will erase the contents from the Note field on the Add 
Note form.

 If a note is attached to a call record, selecting the Add Note function will 
allow the user to edit the existing note.

 When a Note is attached to a call record, the Note will be shown within the 
active call entry.

 When a Note is attached to a call record, the Note will be shown in the Call 
Log entry for that call.

Figure 3-14  Add Note Screen
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SECTION 2 DIRECTORY VIEW

An online company directory, contact list, and personal list are provided to assist the 
user in handling call activity. The Directory provides the user with quick access to 
contact information and an easy method to send calls to other extensions on their 
phone system. The Contact List serves as an on-line phone/address book for 
frequently dialed external numbers. The Personal List is a private version of an online 
phone/address book. The Directory, Contact List, and Personal List are displayed in a 
separate window from the call control application to provide additional flexibility in the 
management of call activity.

2.1 Opening the Directory View

 To open the Directory View from Full Window mode, select 
Window → Directory from the main menu.

Figure 3-15 Directory View Screen shows an example of the Directory View.  

Figure 3-15  Directory View Screen
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The Directory consists of the following areas:  

2.1.1 Title Bar and Main Menu

The Title Bar and Main Menu provide the standard windows 
controls and access to basic operations and utilities through pull 
down menus.

The standard Windows controls on the Title Bar are as follows:  

The Main Menu provides a drop down menu, which lists all of the 
functions available within a selected category. The functions 
available from the Main Menu are as follows: 

File  

Title Bar and Main 
Menu

Provides the standard windows controls and access to standard 
operations and utilities through the pull down menus.

Function Toolbar Provides quick access to functions that maintain the directories and 
change the database view.

Search Area Allows the user to quickly locate an entry in the table by name.

Table Viewer Presents the database contents in a tabular format with each 
column showing a different data item for the listed entries.

Minimize Hide the Directory View and include an entry to restore 
the form in the Windows task bar.

Maximize/Restore Change the size of the Directory View. Maximize 
increases the size of the window to fill the entire display. 
The Restore function reduces the size of the window to 
the previous dimensions.

Close Exit the Directory View.

New Entry Add a new entry to the current database.

Departments/Companies Setup a new Department or Company within the 
database.

Properties Edit the current settings for the selected database 
entry.

Delete Remove the selected entry from the database.

Print Print the contents of the database. Available print 
options are: Print All, Print Selected, Page Setup, 
and Print Preview.

Exit Close the Directory View.
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Edit  

View  

Help  

2.1.2 Function Toolbar

The Function Toolbar provides access to the functions that are 
used to maintain the database and change the layout of the Directory 
View. A function on the toolbar can be selected by using the mouse 
to click on the desired function button.

The functions available on the Function Toolbar are as follows:

NEW  

PROPERTIES

DELETE

Select All Select all entries in the database.

Search Use the Search function to locate an entry by 
Name.

Hidden Entries Hide/Unhide entries that have their visibility 
attribute set to "Hide".

Set Visible Actions Hide/Unhide the list of actions that appear in the 
pop-up menu.

Set Visible Columns Hide/Unhide the columns that appear in the Table 
Viewer.

Contents and Index Access the on-line help system by topic.

About View the copyright notice and current revision of 
the desktop application.

New Entry

New Department
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PRINT  

ACTION  

DIRECTORY

CONTACTS

PERSONAL

2.1.3 Search Area

The Search Area allows the user to quickly locate an entry in the 
database by Name field. The following rules apply to using the 
search area:

 To access the Search capability click inside the Search field on the 
Directory window.

 To search for entries that match the first name, enter the full or partial 
search string in the Search field. Example: Entering "John" will list all 
entries with first names of John and Johnny.

 To search for entries that match a full or partial first and last name enter 
the first name, followed by a space, followed by the last name. 
Example: Entering "John Stevens" will list John Stevens and Johnny 
Stevenson. Example: Entering "S T" will list all entries whose first name 
starts with S and last name starts with T.

 To search for entries that match only the last name enter a space as the 
first character in the Search field, followed by the full or partial last 
name. Example: Entering " T" will list all entries whose last name starts 
with T.

 To Clear the Search results delete all the characters in the Search field 
or press the Esc key on the keyboard while the cursor is in the Search 
field.

Print All

Print Selected

Properties

Dial Extension

Properties

Delete

Add to Speed Dial
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2.1.4 Table Viewer

 The Table Viewer displays the contents of the selected database in 
tabular format.

 Each column represents a field within the database structure.

 Each row represents an entry within the selected database.

 The column widths can be adjusted by “dragging” one edge of the 
column in the header row to a new position.

 The column order can be changed by dragging the column header to a 
new position.

 The visible columns can be modified by using the View → Set Visible 
Columns function on the main menu under View.   

 A right mouse click on a row will open a pop-up menu that displays all of 
the available functions for that entry.

Figure 3-16  Select Visible Columns Screen
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2.2 Company Directory

The Company Directory database maintains a list of extensions on the user’s 
phone system.

Upon startup the application creates a directory entry for every extension that 
is programmed on the user’s phone as a one-touch key. Additional entries can 
be manually created using the Add Entry function. Operations that can be 
performed using the Company Directory are described in the following 
sections.

2.2.1 Adding a New Entry to the Directory

On the File menu, selecting New Entry opens the following form to 
create a new directory entry (refer to Figure 3-17 Directory 
Maintenance Screen).  

Figure 3-17  Directory Maintenance Screen
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 The following fields are configured for text entry:

 First Name

 Last Name

 Extension

 Title

 E-Mail

 Location

 Supervisor Name

 Supervisor Phone

 Assistant Name

 Assistant Phone

 Notes

 The Department field is a drop down list of all of the Departments that 
have been defined.

 The Hide Directory Entry option will hide this entry from being visible in 
the Table Viewer.

 The Hide BLF button applies to extensions that have associated BLF 
buttons within the Full Window mode. Selecting this option will hide the 
associated BLF.

 To enter an alternate number, select New in the Alternate Number 
area, and enter the telephone number and type.

 Selecting Save will add the new entry to the Directory and exit the 
Directory Maintenance menu. 

 Selecting Add will save the new entry and clear the form for a new 
entry.

 To add a new Department to the Directory, from the New button within 
the Directory window, select New Department.    

Figure 3-18  Departments Screen
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2.2.2 Modifying an Entry in the Directory

 Highlighting a directory entry and from the File menu, selecting 
Properties will open the Directory Maintenance form for the selected 
entry.

 To modify an Alternate Number, select an Alternate Number and then 
click the Modify button to view and edit the current number and type 
fields.

 Clicking on Save will apply the changes to the Directory.

 Clicking on Cancel will discard the changes to the Directory.

2.2.3 Deleting an Entry from the Directory

 Selecting the directory entry with a right mouse click and selecting the 
Delete option on the pop-up menu will remove the selected entry from 
the Directory.

 Highlighting the directory entry and from the File menu selecting the 
Delete option will remove the selected entry from the Directory.

 Highlighting multiple entries and applying the Delete command will 
delete all of the entries in the selected range.

2.2.4 Printing the Directory

 From the File menu, selecting the Print option, followed by Print All will 
cause the entire directory to be sent to the default printer.

 Highlighting a set of entries to be printed and selecting 
File → Print → Print Selected from the main will cause the selected 
directory entries to be sent to the default printer.

2.3 Contacts/Personal Lists

The Contacts and Personal databases are used to maintain a list of business 
contacts and personal contacts.

Contacts and Personal Contacts can be imported into the directory from a .csv 
file.  From the File menu, Import and Export options are available to create 
and maintain the Contacts and Personal Contacts database via a .csv file.

Operations that can be performed using the Contacts/Personal databases are 
described in the following sections.



3 - 22 Toolbar Functions

___________________________________________________________________________________

___________________________________________________________________________________Issue 3.01 SL1100

2.3.1 Adding a New Entry to the Contacts/Personal List

On the File menu selecting New Entry will open the following form to 
create a new entry (refer to Figure 3-19 Contacts/Personal List).  

 The following fields are configured for text entry:

 First Name

 Last Name

 Telephone

 Title

 E-Mail

 Address

 City

 State/Prov

 Zip/Postal

 Country

 Notes

 The Company Name field is a drop down list of all of the Companies 
that have been defined.

 To enter an alternate number, select New in the Alternate Number 
area, and enter the telephone number and type.

Figure 3-19  Contacts/Personal List
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 Selecting Save will add the new entry to the Directory and exit the 
Directory Maintenance menu. 

 Selecting Add will save the new entry and clear the form for a new 
entry.

 To add a new Company to the Directory, from the New button within the 
Directory window, select New Company, enter the name of the 
company and click OK.

2.3.2 Modifying an Entry in the Contacts/Personal List

 Highlighting an entry and from the File menu, selecting Properties will 
open the database form for the selected entry.

 To modify an Alternate Number, select an Alternate Number and then 
click the Modify button to view and edit the current number and type 
fields.

 Clicking on Save will apply the changes to the Contacts/Personal list.

 Clicking on Cancel will discard the changes to the Contacts/Personal.

2.3.3 Deleting an Entry from the Contacts/Personal List

 Selecting the entry with a right mouse click and selecting the Delete 
option on the pop-up menu will remove the selected entry from the 
database.

 Highlighting the entry and from the File menu selecting the Delete 
option will remove the selected entry from the database.

 Highlighting multiple entries and applying the Delete command will 
delete all of the entries in the selected range.

2.3.4 Printing the Directory

 From the File menu, selecting the Print option, followed by Print All will 
cause the entire database to be sent to the default printer.

 Highlighting a set of entries to be printed and selecting 
File → Print → Print Selected from the main menu will cause the 
selected database entries to be sent to the default printer.
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SECTION 3 CALL LOG VIEW

The desktop application maintains a Call Log, which provides a historical trace of the 
user’s call activity. Each inbound and outbound call generates a record in the call log. 
This information can be used to retrieve details about specific calls and perform 
functions such as re-dialing a previous call.

3.1 Opening the Call Log

 To open the Call Log from Full Window mode, select Window → Call Log 
from the main menu.

Figure 3-20 Call Log Screen shows an example of the Call Log View.  

The Directory consists of the following areas:

 The Title Bar and Main Menu provides the standard windows controls and 
access to standard operations and utilities through the pull down menus.

 The Filter Toolbar allows the user to apply filters to the visible call records.

 The Record Viewer presents the call log records in a tabular format with 
each column showing a different attribute of the call record.

Figure 3-20  Call Log Screen
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Each of these screen regions is further described in the following sections.

3.1.1 Title Bar and Main Menu

The standard Windows controls on the Title Bar are as follows:

 Minimize – Hide the Call Log View and include an entry to restore the 
form in the Windows task bar.

 Maximize/Restore – Change the size of the Call Log View. Maximize 
increases the size of the window to fill the entire display, The Restore 
function reduces the size of the window to the previous dimensions.

 Close – Exit the Call Log View.

The Main Menu provides a drop down menu, which lists all of the 
functions available within a selected category. The functions 
available from the Main Menu are as follows: 

 Call Log 

 Delete – Delete a call record from the Call Log.

 Print – Print the contents of the call log. Available print options are 
Print All, Print Selected, Page Setup, and Print Preview.

 Archive – Save the call history to an external file.

 View

 Set Visible Columns – Hide/Unhide the columns that appear in the 
Call Log.

3.1.2 Filter Toolbar

The Filter Toolbar allows the user to select the set of call records that 
will be displayed in the Call Log view, as follows:

 Selecting Inbound will only display the call records for incoming calls.

 Selecting Outbound will only display the call records for outgoing calls.

 Selecting Missed will only display the incoming calls that were not 
answered.

 Selecting All will display the entire list of call records.
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3.1.3 Record Viewer

 The Record Viewer displays the list of call records as indicated by the 
selected filter.

 Each column represents an attribute of the call record.

 Each row represents a call record.

 A disk icon in the Type column indicates that a recording is attached to 
the call record.

 The column widths can be adjusted by “dragging” one edge of the 
column in the header row to a new position.

 The column order can be changed by dragging the column header to a 
new position.

 The visible columns can be modified by using the View → Set Visible 
Columns function on the main menu.  

 A right mouse click on a row will open a pop-up menu that displays all of 
the available functions for that record.

 A double click on an entry when the phone is idle will initiate a redial to 
the selected entry.

Figure 3-21  Visible Columns Menu
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3.2 Deleting a Record from the Call Log

 Selecting a record with a right mouse click and selecting the Delete option 
on the pop-up menu removes the selected record from the Call Log.

 Highlighting a record and from the Call Log menu and selecting the 
Delete option removes the selected record from the Call Log.

 Highlighting multiple records and applying the Delete command deletes all 
of the records in the selected range.

3.3 Printing the Call Log

 From the Call Log menu, selecting the Print option, followed by Print All 
causes the entire call history to be sent to the default printer.

 Highlighting a set of records to be printed and selecting Call
Log → Print → Print Selected from the main menu causes the selected 
call log entries to be sent to the default printer.

3.4 Archiving the Call Log

Archiving the Call Log is beneficial for reducing the number of call records 
displayed within the application, and therefore, improving access when 
searching for individual records. The archival process also provides a method 
of backing up the call history and storing the records off-line for future access.

 From the Call Log menu, selecting the Archive option opens the Call Log 
Archive menu (refer to Figure 3-22 Call Log Archive Screen).   

Figure 3-22  Call Log Archive Screen
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 Selecting the Start Date and End Date for the archive specifies the range 
of records to be archived.

 The Archive File Location field specifies the name of the file that will be 
created to hold the archive.

 Selecting Archive will create the specified archive file in CSV (Comma 
Separated Values) format.

 After the archive file is created, all of the selected archive records will be 
removed from the call log.

 Selecting Cancel will close the Call Log Archive dialog without creating an 
archive file.
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Chapter 4 Outlook Add-In

SECTION 1 OUTLOOK ADD-IN

The Outlook Add-In allows users to make calls, End Call, Conference, Transfer, and 
perform screen pops through the Contacts folder within MS Outlook using the NEC 
Desktop application. The Outlook Add-In is installed during installation of the Desktop 
Application. The Desktop Application must be running for the Outlook Add-In to 
function.

1.1 Configuration

There are two pieces needed when configuring the Outlook Add-In. The first 
uses the Desktop Configuration Wizard to define the SL1100 information, 
License information, and extension information just like configuring the 
Desktop Application. Like the Desktop Application, the CPU must have a 
Softphone license for each user that will use the Outlook Add-In. Refer to 
Chapter 2 Installation for programming and detailed information about the 
Desktop Configuration Wizard.
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The second uses Outlook Add-In within MS Outlook. First choose NEC 
Desktop Telephony Settings from the Tools Menu within Outlook.  

Figure 4-1  Outlook Configuration
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The NEC Desktop Screen Pop Settings window will open.  

 Check the Enable box to enable the Outlook Add-In.

 Check the Automatically launch NEC Desktop Suite when Outlook starts if 
this is desired.

 Desktop must be running for the Outlook Add-in to function.

 Click on the Reinitialize button to start the connection to the SL1100.

 The Activation option determines at what point the contact will be located and 
displayed.

 Click on the Pick Folder button to specify an Outlook folder other than the 
default Contacts folder.

 The Call Filter option determines which types of calls initiate a screen pop (all 
calls or external calls only).

Figure 4-2  NEC Desktop Telephony Settings
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1.2 Making a Call

When the Outlook Contacts folder is the active window, there are two different 
ways the user can make a call to any of the numbers associated with a 
contact. The first way is from the NEC Desktop Dial button on the Outlook 
toolbar.   

 A single click on the button will drop down all numbers associated with the 
highlighted contact.

 A second click will dial the number selected.

The second way to dial the contact is by right clicking the contact and 
choosing NEC Call from NEC Desktop.  

 A submenu will open off of the NEC Call with all numbers associated with the 
highlighted contact.

 Highlight one of the numbers and click to dial the number.

Figure 4-3  NEC Dial Button

Figure 4-4  Right Click for NEC Call
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1.3 Conference

When the extension the Outlook Add-In is associated with is on an active call, 
there are two different ways the user can make a Conference Call with a 
contact and the active call. The first way is from the NEC Conference button 
on the Outlook toolbar.   

 A single click on the button will drop down all numbers associated with the 
highlighted contact.

 A second click will initiate a Conference to the number selected.

The Conference Call window will appear.   

 Once the destination party answers, click the Complete button to complete the 
Conference.

 Either before the destination party answers or after they answer, click the 
Disconnect button to disconnect with the destination party and be reconnected 
to the original caller.

Figure 4-5  NEC Conference Button

Figure 4-6  Conference Call Window
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The second way to Conference in a contact is by right clicking the contact and 
choosing NEC Conference.  

 A submenu will open off of the NEC Conference with all numbers associated 
with the highlighted contact.

 Highlight one of the numbers and click to conference the number with an active 
call.

The Conference Call window will appear.  

 Once the destination party answers, click the Complete button to complete the 
Conference.

 Either before the destination party answers or after they answer, click the 
Disconnect button to disconnect with the destination party and be reconnected 
to the original caller.

Figure 4-7  Right Click for NEC Conference

Figure 4-8  Conference Call Window
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1.4 Transfer

When the extension the Outlook Add-In is associated with is on an active call, 
there are two different ways the user can transfer the call to a contact. The first 
way is from the NEC Transfer button on the Outlook toolbar.   

 A single click on the button will drop down all numbers associated with the 
highlighted contact.

 A second click will initiate a Transfer to the number selected.

The Transfer Call window will appear.  

 Click the Start button to begin a supervised Transfer.

 Click the Blind button to make a blind or unsupervised Transfer to the number 
selected.

 Click the Cancel button to cancel the Transfer.

 Click the Complete button to complete the Transfer.

 Either before the destination party answers or after they answer, click the 
Disconnect button to disconnect with the destination party and be reconnected 
to the original caller.

Figure 4-9  NEC Transfer Button

Figure 4-10  Transfer Call Window
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The second way to Transfer a call to a contact is by right clicking the contact 
and choosing NEC Transfer.  

 A submenu will open off of the NEC Transfer with all numbers associated with 
the highlighted contact.

 Highlight one of the numbers and click to transfer the active call to the number 
selected.

The Transfer Call window will appear.   

 Click the Start button to begin a supervised Transfer.

 Click the Blind button to make a blind or unsupervised Transfer to the number 
selected.

 Click the Cancel button to cancel the Transfer.

 Click the Complete button to complete the Transfer.

Figure 4-11  NEC Transfer Right Click

Figure 4-12  Transfer Call Window
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 Either before the destination party answers or after they answer, click the 
Disconnect button to disconnect with the destination party and be reconnected 
to the original caller.

1.5 End Call

When the extension the Outlook Add-In is associated with is on an active call, 
the user can end the call by clicking any of the three buttons, NEC Desktop 
Dial, NEC Transfer, or NEC Conference, and choosing End Call.   

Figure 4-13  End Call
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Chapter 5 Desktop Registration and Softphone 
Override

The Desktop Application registers with the SL1100 system as an IP (SIP) Station 
when a non-Deskset Only license level is chosen in the Configuration Wizard.  This is 
the case for all non-Deskset Only modes [i.e., Softphone, PC Assistant controlling a 
Softphone, PC Assistant Controlling a Deskset (physical phone). This means that a 
Desktop Application that is run as a PC Assistant controlling a deskset (physical 
phone) uses an additional port from the system capacity when a non-Deskset Only 
license level is chosen in the configuration. In this scenario, two ports are in use, one 
for the physical extension and one for the Desktop Application connection. If the 
Desktop Application is run as just a Softphone, or as a PC Assistant controlling a 
Softphone, only port the Softphone registers with is used. If the Desktop application is 
run for a deskset (physical phone) and a Deskset Only license level is chosen, no 
additional port is taken by the Desktop.

SECTION 1 REGISTRATION TYPES

When the desktop is run for a Softphone or a non-Deskset Only license level, the 
Desktop application registers as an IP station. There are three types of registration; 
Plug and Play, Automatic, and Manual. Plug and Play requires no user name and 
password.  Automatic requires a user name and password and it can be entered into 
the configuration so the user never has to enter it.  Manual requires a user name and 
password and the user is prompted to enter them.

Manual registration is required if the Softphone is to override an IP multiline phone 
and use the same extension number.  When this is done, the IP multiline phone goes 
into a Log Off state and the Softphone comes up as the extension the IP phone used 
to be.  This allows a user to use the same extension whether in the office or on the 
road.
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If automatic or manual mode is used, the user must enter a user name and password.  
If the Desktop Application is run in deskset mode (controlling a physical phone) and 
the deskset phone used is an IP phone, the user name and password used for the 
Desktop Application is different than that of the actual IP phone.  Below outlines 
examples of a SL1100 system set for Automatic or Manual registration.  The example 
assumes the system has 32 digital stations using ports 1~32 and eight IP stations 
using ports 33~40.  The number plan has extensions 101~199 assigned to ports 
1~99.

 Example 1
IP station extension 150 is using port 33 and logs in with the user name and 
password assigned to extension 150.  If a user wants to run a Desktop 
Application for extension 150, a new user name and password must be defined.  
This username and password must be assigned to an unused port.  In this 
example, it can be ports 41~99 and the example will use port 41 (ext 141).  In 
Automatic registration, the user name and password assigned to extension 141 
is entered in the Desktop Configuration.  In Manual registration, when the 
Desktop application is launched, the user will be prompted for a user name and 
password.  The user would enter the user name and password assigned to 
extension 141.  At this point, port 41 will no longer be available in the system 
because it is registered to the PC running the Desktop Application for extension 
150.  The key point in this example is that the Desktop Application running in 
deskset mode for an IP phone cannot use the same user name and password 
assigned to the IP phone because the Desktop Application connection uses a 
different port.

 Example 2
 Digital station extension 101 is using port 1.  If a user wants to run a Desktop 
Application for extension 101, a user name and password must be assigned to a 
port the Desktop Application will use to register with the system.  In this 
example, port 42 (ext 142) will be used.  In Automatic registration, the user name 
and password assigned to extension 142 is entered in the Desktop 
Configuration.  In Manual registration, when the Desktop Application is 
launched, the user will be prompted for a user name and password.  The user 
would enter the user name and password assigned to extension 142.  At this 
point, port 42 will no longer be available in the system because it is registered to 
the PC running the Desktop Applications for extension 101.
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 Example 3
IP station extension 151 is using port 34 and logs in with the user name and 
password assigned to extension 151.  The person that sits at extension 151 in 
the office goes out of the office and wishes to run the Desktop Application as a 
Softphone for extension 151.  This is only possible if the registration mode is 
manual.  When the Desktop Application is launched, the user will be prompted 
for a user name and password.  The user would enter the user name and 
password assigned to extension 151.  The IP station that was 151 in the office 
will show Log Off in the display, and the Desktop Application Softphone will 
come up as extension 151.  When the user is back in the office, they would press 
the exit soft key and the phone will reset and prompt for a login.  They would 
enter the user name and password assigned to extension 151, and the IP phone 
will come back up as extension 151.

 Example 4
A user wishes to have a Softphone that is a different extension than the one they 
use in the office.  A user name and password can be assigned to extension 143.  
In Automatic registration, the user name and password assigned to extension 
143 is entered in the Desktop Configuration.  In Manual registration, when the 
user launches the Desktop Application, the user will be prompted for a 
password.  The user would enter the user name and password assigned to 
extension 143, and the Softphone extension will be 143.  At this point, port 43 
will no longer be available in the system because it is registered to the PC 
running the Desktop Application for Softphone extension 143.

SECTION 2 SERVICE CONDITIONS

The following service conditions apply:

  When running Desktop Applications in deskset mode for an IP phone when the 
registration mode is set to automatic or manual, the user name and password 
must be different than that of the IP phone.

 A Softphone that is assigned a DSS console cannot override another IP phone.

 A Softphone cannot override an IP phone that is assigned a DSS console.

 Once a Softphone with a DSS console is logged in, it cannot log in with a 
different user name and password.

 Once a desktop is launched on one PC using a User ID and Password in 
deskset or Softphone mode, the same User ID and Password cannot be used on 
a different PC in a different mode.

 In the first release of SL1100, Network Address Translation (NAT) is not 
supported.  Because of this, any IP multiline terminal or Desktop Applications 
must appear to be on the same network as the SL1100 VoIP Interface 
(VOIPDB).  For remote Desktop Applications, such as the Softphone, this can be 
achieved by using a VPN connection to the network where the SL1100 resides.



5 - 4 Desktop Registration and Softphone Override

___________________________________________________________________________________

___________________________________________________________________________________Issue 3.01 SL1100

THIS PAGE INTENTIONALLY LEFT BLANK



Desktop Suite 6 - 1

___________________________________________________________________________________

___________________________________________________________________________________

Chapter 6 Desktop Application Startup

The Desktop Application can be started in any of the following ways:

 Double-clicking on the desktop application icon within the Windows desktop 
area.

 Selecting Start/All Programs/NEC/NEC Desktop Suite

During startup, the following actions are performed:

 The first time the application is started after installation, the Configuration Wizard 
automatically runs.

SECTION 1 FULL WINDOW MODE

This User Interface mode presents valuable information about the current call activity 
and provides easy access to the basic operations required by the user. Using either 
the mouse or keyboard, the user can quickly move between the different areas of the 
screen to search the company directory, and view the BLF status of the individual 
lines configured via DSS/One Touch keys. An example of the Full Window Mode is 
shown in Figure 6-1 Full Window Mode Screen. 

Figure 6-1  Full Window Mode Screen
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The main screen consists of the following areas:  

1.1 Title Bar and Main Menu

The Title Bar and Main Menu provide the standard windows controls and 
access to basic operations and utilities through pull down menus.

The standard Windows controls on the Title Bar are as follows: 

The Main Menu provides a drop down menu, which lists all of the functions 
available within a selected category. The functions available from the Main 
Menu are as follows:

File 

View 

Title Bar and Main Menu Provides the standard windows controls and access to standard 
operations and utilities through the pull down menus.

Function Toolbar Provides quick access to the most commonly used call processing 
functions.

Active Call List Displays information about the current call, a list of all calls currently 
active on the console.

BLF/DSS Area Provides the Busy Lamp field and Direct Station Select functionality, 
comparable to a DSS module.

Minimize Hide the application's main window and include an entry to restore 
the application in the Windows task bar.

Maximize/Restore Change the size of the application main window. Maximize increases 
the size of the window to fill the entire display. The Restore function 
reduces the size of the main window to the previous dimensions.

Close Exit the desktop application.

Exit Close the Desktop Application.

Sort BLF By Change the sort order of the BLF buttons. Sort options are 
Extension and Name.
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Tools 

Window  

Help  

1.2 Function Toolbar

The Function Toolbar provides quick access to the most commonly used call 
processing functions. A function on the toolbar can be selected by using the 
mouse to click on the desired function button or by pressing the associated 
hotkey sequence on the keyboard. If additional information is required to 
complete the operation, then a supporting menu is displayed requesting 
additional input from the user.

Individual buttons on the Function Toolbar become disabled if the function is 
not allowed for the current state of the telephone. For example, the Answer 
button is only enabled when a call is ringing on the telephone.

Available functions are:   

Preferences Customize operational settings for the desktop application.

Configuration 
Wizard

Launch to configuration wizard to modify application settings.

Call Log Open a separate window to view the call history.

Directory Open a separate window to view the Directory/Contact List.

Contents and 
Index

Access the on-line help system by topic.

About View the copyright notice and current revision of the desktop 
application.

Answer Hang Up

Auto Handset/Auto Headset Hold

Barge In Last Number Redial

Call Redirect Page

Conference Park

Dial Pickup Other Group

Directed Call Pickup Transfer
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The operation of each of these functions is further described in Section 1 
Toolbar Functions on page 3-1.

1.3 Active Call List

The Active Call List displays all of the calls that are currently being handled by 
the application. The list includes calls that are in the following states:

 Ringing

 Connected

 Held

1.3.1 Active Call List Format

The active call entry that is displayed on the top of the list is always 
the connected (active) call.

Each entry in the active call list includes the following information, 
based upon the current state of the call:

 Line/Trunk Identifier

 Connection Status

 Timer displaying time in current state

 Calling Party/Called Party Identification

 User-defined notes

 DNIS information when provided.

The color of the frame for each entry in the active call list also 
indicates the state of the call. The following table shows the colors 
that represent each call state.   

Calls are automatically removed from the active call list when they are 
disconnected.

Do Not Disturb Unpark

Forward Calls Voice Mail

Group Call Pickup

Table 6-1  Call State Colors

State Frame Color

Active/Connected Green

Ringing Red

Held Yellow
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1.3.2 Active Call List Operations

The following operations are valid within the Active Call List:

 Clicking on a ringing call automatically answers that call.

 A right mouse click on a ringing call gives the option to Redirect or 
Show Contact.

1.4 BLF/DSS Area

The Busy Lamp Field (BLF)/Direct Station Select (DSS) Area provides for 
monitoring and quickly accessing different phone system resources.

1.4.1 BLF/DSS Tabs

Each key on the BLF/DSS Tab is used to monitor another station on 
the telephone system and provides one-touch access to that station. 
The BLF/DSS Tab also provides the Presence Status for the user 
associated with the station selected. In addition to the basic add-on 
module functionality, the BLF/DSS Tab also provides access to other 
telephony functions.

1.4.1.1 BLF/DSS Programming

 By default the BLF/DSS view includes an entry for the user 
local extension.

 Additional BLF buttons are created for each extension that is 
programmed as a one-touch key on the user’s phone.  (MB 
15-07-01 and 30-03-01).

 One-Touch keys must be programmed on buttons that 
physically appear on the phone or a console connected to 
the phone for DSS/BLF status.

 The desktop application acquires the list of programmed 
one-touch keys at startup.

 Any changes to the phone programming that occur while the 
application is running are reflected in the application only 
after the application is restarted.

 Alternately, the Tools  → Preferences → BLF/DSS tab 
includes a Synchronize function that reads the current 
phone programming.

1.4.1.2 BLF Button Design

 Each BLF button includes an LED image, followed by an 
identifier.

 The LED image changes color to indicate the current state 
of the extension.

 The supported colors/states are as follows: Gray (Idle), 
Green (Busy), Red (Call Forward Immediate/DND All).
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 The label can show the extension number, directory name 
associated with this extension, or both, as determined by the 
user settings.

1.4.1.3 BLF/DSS Layout

The Preferences → BLF/DSS tab specifies the layout of the 
BLF/DSS area. Through this dialog the user can set the 
following:

 Define BLF Groups (tabs).

 Set Visible BLF Groups (tabs).

 Specify members of each BLF Group.

 Define label format for the BLF buttons.

 Specify the name order used on the BLF and Directory 
views.

The Preferences dialog is further defined in the Preferences 
section of this document.

The user can also change the sort order of the BLF buttons 
using the View → Sort BLF By options on the Main Menu. The 
available sort options are by Extension, by First Name, or by 
Last Name.

1.4.1.4 BLF/DSS Operations

The BLF/DSS buttons provide one-touch access as follows:

 When the local phone is idle, selecting an idle BLF button 
initiates a call to that extension.

 When the local phone has an active call, selecting an idle 
BLF button initiates a transfer to that extension.

 Performing a right mouse click on a BLF button provides 
access to the following functions:

 Dial

 E-Mail

Each of these functions is further described in the Functions 
section of this document.
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1.4.1.5 Speed Dial Tab

 A special tab labeled Speed Dial is included in the BLF/DSS 
area. When selected, this tab displays a set of buttons that 
the user has designated as speed dials.

 Clicking on an entry in the Speed Dial list immediately 
generates a call to the selected number.

 Entries are added to the Speed Dial list through the 
Directory/Contact List/Personal windows. Then either right 
click on the contact entry or click on the action tab and select 
Add Speed Dial.

 A right-mouse click on a Speed Dial entry opens a menu that 
allows the user to Dial the selected entry or Delete the entry 
from the Speed Dial list.
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Chapter 7 Application Level Configuration

SECTION 1 INTRODUCTION

The Preferences function allows the user to customize the desktop application user 
interface and operation.

 From the Full Window mode, the Preferences settings can be accessed by 
selecting Tools → Preferences on the main menu.

SECTION 2 PREFERENCES MENU

When the Preferences function is selected, the Preferences Menu (Figure 7-1 
Preferences – General Menu on page 7-2) is displayed.

The tabs available from the Preferences menu, which are listed below, are described 
in this chapter.

 General

 BLF/DSS

 Tool Buttons

 Shortcuts

 Dialing Rules

 Voice Mail

 Notification Settings
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2.1 Preferences – General

 The Pop-Up on incoming calls option applies when the application in Full 
Window mode is minimized. If this option is selected, the application will 
be restored from a minimized state when an incoming call is received.

 The Make top application on incoming calls applies to the Full Window 
mode. When selected, this option causes the application window to 
become the top active application when an incoming call is received.

 The Enable E-Mail integration option can be selected to utilize a 
MAPI-compatible e-mail client in conjunction with the desktop application. 
E-mail functions are provided within the call log and for directory/contact 
list entries that have designated e-mail addresses.

Figure 7-1  Preferences – General Menu
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 The Enable ringing through PC speakers option controls whether a 
ringing tone is played through the default sound device for each incoming 
call.

 If headphones are plugged in then the ringing will be played across the headphones 
and not the speakers.

 The Show confirm dialog on exit controls if a confirmation dialog is 
presented each time the user closes the application.

2.2 Preferences – BLF/DSS

 The Synchronize button retrieves the current line key settings from the 
phone system and updates the layout of the BLF panel accordingly.  The 
O&M information must be defined in Desktop Configuration for this to be 
available.

Figure 7-2  Preferences – BLF/DSS Menu
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 The Visible Tabs list controls the tabs that are visible and hidden on the 
BLF panel. Only the tabs that are checked are shown on the BLF panel.

 The Move Up and Move Down buttons allow the user to re-arrange the 
order of the BLF tabs. Selecting an entry and then pressing one of these 
buttons moves the entry in the desired direction.

 The New button can be used to define a new BLF tab entry.

 The Delete button removes the selected BLF tab from the list.

 The Properties button opens up the definition window for the selected 
BLF tab.

 The Label Format option allows the user to specify which values are 
shown on each BLF button (Extension only, Name only, or both Extension 
and name).

 The Name Display option allows the user to select the format used in the 
BLF and Directory for displaying First Name and Last Name.

 BLF Appearance can be used to set the preferred size of the BLF 
buttons.
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2.3 Preferences – Tool Buttons

 The Available Tool Buttons lists all of the function buttons that are 
available within the application.

 Only the entries that are checked are shown on the function toolbar.

 The Move Up and Move Down buttons are used to re-arrange the order of 
the function buttons.

 The Accelerator field is used to specify a hotkey to associate with a 
function. The Description text explains how to set a hotkey for a function.

 The Image Size option allows the user to select the size of the buttons on 
the toolbar (Small, Medium, Large).

Figure 7-3  Preferences – Tool Buttons Menu
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2.4 Preferences – Screen Pop

 The Contact Manager option selects which application to utilize to pop a 
contact entry.

 Supported applications are ACT! 2005 and higher, Goldmine 6.7 and higher, Time 
Matters, Tiger Paw and Browser-based CRMs.

 SL-DT-CRM Integration-LIC part number 1100095 is required (License 
code 5510).

 ACT! 2001, 2012, and 2013 are supported with the following conditions:

In Act>Tools>Preferences>Communications>Dialer Preferences 
choose NEC Single Line Device as modem or line and uncheck Hide 
dialer after dialing.

Configure Windows Phone and Modem properties for local dialing.

Figure 7-4  Preferences – Screen Pop Menu
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With ACT! 2012 and 2013, either use the Hang up button in the ACT! 
dialer window to disconnect the call, or toggle the handset if you hang up 
the phone and close the ACT! dialer window. Failure to do either would 
hold the dialer open in ACT!.

With ACT! 2013, a reboot is required after setting the integration up.

 The Settings button allows the user to designate specific information 
about the selected contact application.

 To pass Caller ID to a Browser-based CRM use %ID where the caller ID should be 
placed in the URL. (For example, www.doyoulikewebsites.com/%ID.)

 The Activation option determines at what point the contact is located and 
displayed.

 The Call Filter option determines which types of calls initiate a screen pop 
(all calls or external calls only).

  The Enable Third Party Interface and Enhanced XML Interface are used 
when integrating third party applications via XML.
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2.5 Preferences – Shortcuts

 The One touch transfer will initiate option specifies which action type of 
transfer (Supervised or Immediate) is initiated when the user clicks on an 
idle BLF button with an active call.

 The Enable Highlighted Dial Feature option turns on the ability to 
Highlight a number in any program and have the Desktop Automatically 
call that number when the number is copied.

Figure 7-5  Preferences – Shortcuts Menu
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2.6 Preferences – Dialing Rules

 The Station Number Length field specifies how many digits internal 
station numbers are.  Additional digits will be ignored.

 The Emergency Number field specifies the number dialed for emergency 
calls.

 The Exception Table is used to define dial strings that are not internal 
calls.  When numbers in this table are dialed, the call will access a trunk.

 The New button is used to add a new number to the Exception Table.

 The Delete button is used to delete the selected number from the 
Exception Table.

Figure 7-6  Preferences – Dialing Rules Menu
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2.7 Preferences – Voice Mail

 The Enable Voicemail Interface option controls if the voice mail functions 
within the application are enabled.

 The Voicemail Pilot Number is specified if transfers to voice mail require 
the pilot number to be utilized instead of the quick transfer to voice mail 
service code.  The Voicemail Pilot Number should also be entered for 
Voicemail to be an option when setting forwarding based on Presence 
settings.

Figure 7-7  Preferences – Voice Mail Menu
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2.8 Preferences – Notification Settings

 Check the Display an alert for missed calls check box to receive a 
notification in the system tray when an incoming call is missed.

 Check the Ignore missed calls to virtual extensions check box to avoid 
receiving a notification in the system tray when a call to a virtual extension 
has been missed.

 The Alert Display section specifies how the alert will display. The alert can 
be displayed by clicking the system tray icon, it can be displayed 
automatically and held until dismissed, or it can be displayed and fade 
slowly.

Figure 7-8  Preferences – Notification Settings Menu
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Chapter 8 Salesforce Integration

This chapter describes the setup and operation that allows the NEC Desktop Suite to 
integrate with Salesforce.com®. This integration allows users to initiate calls to 
contacts from within Salesforce.com and to search for contacts automatically when an 
incoming call is received.

 SL-DT-CRM Integration-LIC part number 1100095 is required (License code 5510).

SECTION 1 OVERVIEW

The Salesforce.com integration module requires a Salesforce.com Professional, 
Enterprise, or Unlimited Edition account. The integration module is compatible with 
the following browsers: Internet Explorer 7, 8, 9 and Firefox 3.6.  Firefox 4 is not 
currently supported.

When integrated with the NEC Desktop Suite, this module provides access to the 
following operations through the Salesforce.com interface:

 Call contact phone number

 Dial phone number directly

 Answer incoming call

 End active call

 Hold active call

 Retrieve a Held call

 Transfer active call

 Pop contact on incoming call that matches phone number

 The Salesforce Adapter v4.0 is required for screen pops to be available when using the 
Professional edition.
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Figure 8-1 Salesforce Screen shows an example of the phone interface within 
Salesforce.com.  

SECTION 2 INSTALLATION

2.1 Installation Procedure

The following steps can be used to install the required components to 
integrate Salesforce.com with the NEC Desktop Suite. This procedure 
requires the installation of SL Desktop v2.0 or higher on the target PC and its 
operation has been verified.

1. Unzip the NECAdapter.zip file into a temporary location.

2. From the temporary location, run Setup.exe as a Windows administrator 
user.

 Default file location: c:\Program Files\NEC\NEC CTI Adapter

 Programs menu location: NEC →  NEC SalesforceCTI

Figure 8-1  Salesforce Screen



SL1100 Issue 3.01

Desktop Suite 8 - 3

___________________________________________________________________________________

___________________________________________________________________________________

2.2 Upgrade Procedure

The following steps can be used to upgrade the Salesforce components from 
an earlier version. This procedure requires the installation of SL Desktop v2.0 
or higher on the target PC and its operation has been verified.

1. Stop the Salesforce.com Call Center Adapter by issuing a right mouse 
click on the Salesforce icon in the notification area. Select the Exit 
function to close the application.

2. Unzip the NECAdapter.zip file into a temporary location.

3. From the temporary location, run SetupSF.exe as a Windows 
administrator user. The installation procedure will indicate that an earlier 
version of the application is being removed.

 Default file location: c:\Program Files\NEC\NEC Salesforce Adapter

 Programs menu location: NEC →NEC SalesforceCTI

SECTION 3 SALESFORCE.COM CONFIGURATION

The following sequence should be performed to configure Salesforce.com for use 
with the NEC Desktop Suite.

1. Log in to Salesforce as an administrator user.

2. Click Setup →  Customize (under App Setup) →  Call Center →  Call Centers.

3. Click Import.

4. Click Browse and navigate to the call center definition file in your NEC Adapter 
program file directory. In default installations, this file is located at:
c:\Program Files\NEC\NEC CTI Adapter\ NecAdapter.xml

5. Click Import.

6. Click Manage Call Center Users.

7. Click Add More Users.

8. Enter search criteria to find a Salesforce user who will be a NEC Call Center 
user. Click Find.

9. Select the checkbox next to the name of one or more users who should have 
access to the NEC Call Center adapter. Click Add to Call Center.
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SECTION 4 DESKTOP SUITE CONFIGURATION

The following sequence should be performed to configure the NEC Desktop Suite to 
use the Salesforce.com integration module.

1. Launch NEC Desktop Suite. Make sure the NEC Desktop Suite application is 
running whenever you wish to use Salesforce.

2. Configure the NEC Desktop Suite.

 Select menu item Tools → Preferences

 Select the Screen Pop tab

 In the Third Party Interface section, check the Enable Third Party Interface 
check box and check the Enhanced XML Interface check box and click the OK 
button.

 These options cannot be enabled unless the Enhanced CRM license is available in the SL1100.  

Figure 8-2  Preferences Screen
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SECTION 5 OPERATION

The following procedure can be used to initiate a call from within Salesforce.com.

1. Launch the NEC Desktop Application.

2. Launch the NEC SalesforceCTI application under Start →  All Programs →  
NEC →  NEC SalesforceCTI. Make sure this application is running whenever 
you wish to use Salesforce.

3. Log in to Salesforce as a NEC Call Center user. You should notice a new Call 
Center section below the tabs at the top in the left column. This section will 
display information about calls being made and received.

4. To dial a phone number:

 Select a phone number for a Contact, Account, or any other item that has a phone 
number. Click the phone icon next to the phone number you wish to dial.

 To end the call, click the red End Call button in the Call Center section.

5. When an incoming call is received, information about the call will be displayed in 
the Call Center section. If the call is from one of your Contacts or Accounts, the 
name of the contact will appear in the Call Center section.

 You will have to answer the call using the NEC Desktop Suite or your phone.

6. Phone Call Notes – you can log notes about the phone call while you are in the 
call or after the call.

7. Configure Wrapup After Call.

 Right-click on the Salesforce system tray icon in the lower right corner of your 
computer screen.

 Select Go To Wrapup After Call if you want to view wrap-up reasons after ending 
a call.

SECTION 6 SERVICE CONDITIONS

If analog Caller ID trunks are being used, Program 14-02-23 must be set to Wait 
Caller ID for Salesforce to receive the caller ID for screen pops.
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Chapter 9 Tigerpaw

SECTION 1 INTRODUCTION

This chapter describes the setup and operation that allows the NEC Desktop Suite to 
integrate with Tigerpaw® software. Tigerpaw software offers a comprehensive contact 
management system that includes account management, scheduling, customer 
history, notes, management of tasks and synchronization with Outlook. The 
integration with Desktop Suite allows users to initiate calls to contacts from within 
Tigerpaw and to open contacts automatically when an incoming call is received.

SECTION 2 OVERVIEW

The Tigerpaw integration is supported in SL Desktop v2.0 or higher.

Desktop Suite has been tested with Tigerpaw versions 9, 10.7.6, and 11.0.244.

The SL1100 CPU must include the LK-DT CRM INTEGRATION-LIC (5310) license to 
enable the Tigerpaw integration. If this license is not installed, the Desktop Suite will 
not display the option to enable Tigerpaw integration.

When the Tigerpaw integration is enabled within the NEC Desktop Suite, the following 
operations are available:

 Pop contact on incoming call that matches phone number.

 Call contact phone number.

SECTION 3 NEC DESKTOP SUITE CONFIGURATION

To configure the NEC Desktop Suite to use the Tigerpaw CRM integration for screen 
pops complete the following:

1. Launch NEC Desktop Suite. Ensure the NEC Desktop Suite application is 
running whenever you wish to use Tigerpaw.
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2. Configure NEC Desktop Suite:

 Select menu item Tools>Preferences.

 Select the Screen Pop tab.

 Select Tigerpaw within the Contact Manager section and click the OK button.

 Set the Activation and Call Filter settings to determine when to initiate the screen 
pop and which type of calls should cause the screen pop.

3. When an incoming call arrives, the Desktop Suite uses the calling line number to 
search the Tigerpaw database for a match. If a match is found, the associated 
contact is displayed, refer to Figure 9-1 Tigerpaw CRM Screen.   

 The contact screen may differ based upon the version of Tigerpaw in use and individual 
configuration settings.

Figure 9-1  Tigerpaw CRM Screen
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SECTION 4 OPERATION

The following can be used to initiate a call from within Tigerpaw:

1. Select the contact to be dialed and open the dialing control, refer to Figure 9-2 
Example of Dial Number Screen.  

 The dialing screen may differ based upon the version of Tigerpaw in use.

2. In the TAPI section, select NEC Single Line Device, refer to Figure 9-2 
Example of Dial Number Screen.

3. Select the Dial button to initiate the call.

4. The Desktop Suite interface will update to show the status of the call.

5. Further operations can be initiated on the active call through the Desktop Suite, 
such as Transfer, Conference, Hold, and HangUp.

Figure 9-2  Example of Dial Number Screen
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Chapter 10 Integration Toolkit

SECTION 1 INTRODUCTION

The Desktop Suite has the ability to support integration with a variety of popular 
third-party CRM applications. These integrations typically allow the third-party 
software to dial numbers stored within the application and screen pop entries based 
upon Caller ID recognition. However, many companies use CRM (Customer 
Resource Management) packages that are industry-specific or, in some cases, 
internally developed.

In order to provide another means to integrate with third-party applications, with UC 
Desktop Suite SL Desktop v2.0 or higher, the Integration Developer’s Toolkit allows 
users to develop their own interface to the Desktop Suite.

 Part number 670940 – LK-DT CRM Integration-LIC license (license code 5310 in Program 
10-50-01) and SL1100 system software Version 4000 are required for the Integration Toolkit.

The Desktop Suite developer’s toolkit consists of a .Net/ActiveX connector module 
and basic documentation that will help a developer get started with the integration. 
The connector module is automatically installed as part of the Desktop Suite client. To 
utilize the connector, the user must have the Enhanced CRM license enabled within 
their SL1100 system.

SECTION 2 TOOLKIT ACTIVATION

The user can enable the Connector integration by choosing the Enhanced XML 
option on the Screen Pop tab of the Preferences dialog (refer to Figure 10-1 
Preferences – Screen Pop Tab on page 10-2). The Desktop Suite is a TCP server 
(listener) for the connector. The default port for the TCP server is 20864. The user can 
change this port by selecting the Settings button on the Screen Pop tab.
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The Connector is a .NET ActiveX DLL. There is a COM class for the Plug-in named 
CrmPlugin.DSApi. A second class, CallEventArgs, is used as a convenience class to 
pass data related to telephony events received from the Desktop Suite. To access the 
DSApi class the integrator must add a reference to the CrmPlugin Typelib.

The class has a single property:

 IsConnected – Returns true if the connection to Desktop Suite is active.

The class has the following methods:

 AnswerCall – Answer the call specified by the call handle parameter.

 ConferenceCall – Initiate a three way conference with the current call and the 
specified destination.

Figure 10-1  Preferences – Screen Pop Tab
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 DialDigits – Send a Dial request to the Desktop Suite. The digits to dial are 
passed as a parameter.

 DropCall – Hangup the call specified by the call handle parameter.

 HoldCall – Place the specified call on hold.

 MakeCall – Send a make call request to the Desktop Suite. The number to dial 
is passed as a parameter.

 RetrieveCall – Retrieve the specified on hold call.

 Shutdown – Close the connection to Desktop Suite.

 Startup – Open a connection to Desktop Suite. Returns true if the connection is 
successful.

 TransferCall – Perform an immediate transfer of the current call to the 
requested destination number.

 TransferCallToVoicemail – Perform an immediate transfer of the current call to 
the destination mail box.

The class raises two events:

 OnConnectionStateChanged – This event is raised when the state of the 
connection to Desktop Suite changes. The ConnectionStateArgs parameter has 
two fields. The IsConnected field indicates whether the connection is active.

 OnCallEvent – This event is raised when a call event is received from Desktop 
Suite. The event has a single parameter of type CallEventArgs.

The class has several properties describing attributes of the event. The same class is 
used both for incoming call status events and dial out status events  The ‘IsOutbound’ 
property may be used to determine the direction of the call. The following properties 
are supported:

 CalledID – The called number or DNIS as identified by the telephone system.

 CallerID – The caller ID for an inbound call or the called ID for an outbound call.

 CallerName – This field is not populated in the current TAPI implementation.

 CallHandle – This field represents an internal ID associated with the call that 
generated the event.

 ChangeTime – The time when the event occurred.

 IsOutbound – A Boolean indicating the direction of the call.

 State – The state of the call as defined in the CallStates enumeration. Valid 
States are: Busy, Conferenced, Connected, Dialing, Dialtone, Disconnected, 
Idle, Offering, OnHold, Proceeding, Ringback, and Unknown.
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 Status – A string representing the status of the call out status messages.

 TrunkNumber – The trunk number of the current call event. A trunk number of 0 
represents an internal call.
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Appendix A Features by License Level

The following table shows the licenses available for the SL Desktop Suite and their 
codes.  

Operational Mode License Code Description

Softphone 5501 Softphone Client

Deskset 5505 Desktop Client
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